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Lesson Objectives

Discuss decisions that must be made before using QuickBooks
Create a new QuickBooks company using the EasyStep Interview
Set QuickBooks preferences in the interview

Record the opening balance for a checking account

Enter customers, jobs, vendors, accounts and items for a QuickBooks company
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Create a QuickBooks Company

A QuickBooks Desktop company contains all the financial records for a single business. Before you
can use QuickBooks, you need to tell QuickBooks about your business, so it can set up your
company file properly.

1. Express Start will set up a new company file based on some standard industry settings. (Any fine-
tuning of the company file can be done later.)

2. Detailed Start opens the EasyStep Interview and will give you more control over fine-tuning your
company file as you set it up.

3. Your other options are to create a file by copying list data from an existing file or by converting
data from another accounting system.

In the Detailed Start option, you will set up the following using the EasyStep Interview:

Company information

Chart of Accounts based on your industry
Company organization

Sales information

Sales tax information

Estimates

Sales receipts

Preferences

Business start date

Create an account and enter the opening balance

Review the Chart of Accounts

Complete company file setup

QuickBooks Desktop 2021 Client Training 7



Lesson 2 - Setup Start the EasyStep Interview

Start the EasyStep Interview

(@

o Step-by-Step: Begin to Add a New Company

1. Start QuickBooks.

2. Click the Create a new company file button from the No Company Open window or choose
New Company from the File menu.

3. Specify whether you are the QuickBooks Desktop Admin user for this new company (in which
case you'll be using or setting up an Intuit ID), or if you're creating the company file on behalf of
the individual who will be the Admin user.

4. Click the Detailed Start button to start the EasyStep Interview.

ab

Let’s set up your business!

Answer some basic questions and we’ll do the rest.
You can always make changes later.

Control the setup and fine-tune the Create a new company file based Convert data from Quicken or other
company file. on an existing one. accounting software.

Detailed Start Create Other Options ¥

4. QuickBooks displays the EasyStep Interview window.

NOTES
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Enter Company Information

@)
0

Step-by-Step: Create a New QuickBooks Company File

Enter Company Information

1. Atthe first Welcome window for the EasyStep Interview, the Enter your company information

window appears.

2. Enter the business name in the Company name field and press Tab.

QuickBooks automatically enters that name into the Legal name field as well. QuickBooks uses
the company name on all reports.

3. Press Tab again and enter the EIN or SSN in the Tax ID field.

4. Complete the remaining contact information for the company. QuickBooks will pull this
information onto sales forms and tax reports when you begin working in the file.
Your screen should resemble the following.

¥ Getanswers
Enter your company information
EasyStep’Interview
QuickBooks uses this information on your tax forms and forms you use to communicate with your
customers and vendors
Interview Progress * Company name ) o oihan Design
Legal name Lockhart Design
The gal forms. Unless y = 3 DBA name, this will probably
Excplain
TaxID 99-1234567
:'-:!_'_FE:E'E Emiployer Identificztion Numbser (EIN) or Social Security Number, Used onhy on tax
L\) Street address 123 Anyroad
city iytown State oy . 2P giaae
Country us. -
Phone 888-565-1234 Fax
Uise the format you would Tk 555) 555-1212
E-mail address "0 @ mybusiness.com
Web site WWW.mybuSIness.com
Need help setting up? * reguired field What if | have more than one business?
FindALocal
+ QuickBooks Expert
(fees may apply) Leave... < Back | Next> |
5. Click Next.
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Choose Your Company Industry

@
o  Step-by-Step: Choose Your Company Industry to Create a

Chart of Accounts

1. Choose your industry from the list to help QuickBooks compile a suggested Chart of Accounts
for your business.

Step Interview

¢ Getanswers

Select your industry
EasyStep’Interview
Tell us your industry and we'll customize QuickBooks to work best for you.

|| You will be able to review our recommendations and change them in this interview. And, you can always
Interview Progress change each of these settings later. Explain

Don't see your industry? Choose an industry that is similar to yours. Examples

Select an industry from the list

USTRY

Accounting or Bookkeeping

Advertising or Public Relations

Agriculture, Ranching, or Farming

Art, Writing, or Photography

Automotive Sales or Repair

Church or Religious Organization

Construction General Contractor

Construction Trades (Plumber, Electrician, HVAC, etc.)

Design, Architecture, or Engineering

i help e How does QuickBooks use my industry selection?
) infuit

FindALocal -
< CuickBooks Expert b =

(fees may apply) b o Leave... < Back

2. Click Next.

NOTES
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Select How Your Company is Organized

@
o Step-by-Step: Select your Company Organization

1. Choose the company’s entity type (for example: Sole Proprietorship, S Corporation, LLC, etc.).
This will allow QuickBooks to create suggested tax mapping for your Chart of Accounts.

2. Click Next.

3. Enter the first month of the business’s fiscal year — commonly January. (Remember, if a
company'’s year-end is December, you would enter January as the first month of the year.) Then
click Next.

4. Inthe Set up your administrator password window, click Next. You can set the password later. If
you don't set up a complex password now (seven characters, including at least one upper case
character and one number), you'll be prompted to do so the next time you open this company.

5. Click Next to create and save the company file.

6. Name your company file (it will be assigned the file type .QBW) and choose the location on your
computer where you wish to save it.

7. Click Save.

NOTES
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Customize QuickBooks for Your Business

After you've saved the company data file, the customization section of the EasyStep Interview
appears. Itis the place where you indicate:

® Whatyou sell
® How and when your customers pay you

® How you pay your bills

Based on your answers, QuickBooks sets preferences for the company file. The preferences enable
certain features of the QuickBooks program.

¥ Getanswers
Customizing QuickBooks for your business
EasyStep’Interview
Mext, we'll customize QuickBooks by turning on features that best meet your business needs. To do
this, we'll ask you questions about:
I
Interview Progress Your industry and what you sell
How and when your customers pay you
How you pay your bills
e = The features that appear in your
; = s ‘“ = 8 5 custom Home page will be based on
e 8 R your answers.
| ¥ 2 2
w—a PE—
=8 ¥ £ o
| 2 24 g =
Not sure what you'll need for your business? Answer the interview questions based on your current
Need help setting up? Frtur needs. You can easily enable additional features later.
Find ALocal -
< QuickBooks Expert ":'
(fees may apply) e Leave... < Back

NOTES
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Indicate What You Sell

You need to indicate what your business sells. In general, businesses either sell products, services or
both. Margaret Lockhart provides consulting services as well as selling products such as fabrics.

@
o  Step-by-Step: Indicate What You Sell

1. Click Next to move to the What do you sell? window.

2. Choose the appropriate option for the business (Services only, Products only, or Both services
and products).

EasyStep Interview

¥ Getanswers

What do you sell?
EasyStep’Interview
1 Services only

Such as consulting, rentals, gym memberships, hair styling senvices, event senvices,
E— construction and labor.
Interview Progress

7 Products only
Such as lamps, fertilizer, books, hardware, tickets, insurance policies. Manufacturers and
distributors should also select this option.

@® Both services and products
3uch as a bicycle repair shop that sells bikes, a carpetinstallation company that sells carpet

eed help setting up? -~
nTur

FindAlLocal =
7 QuickBooks Expert _
(fees may apply) k- Leave... < Back | Next> |
3. Click Next.

NOTES
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Enter Sales Information

Retail companies need to indicate how they want to enter sales. QuickBooks uses this information to
set recommendations for a retail-type business. (Note: you may have encountered these windows in
the EasyStep Interview if you chose a different type of business other than retail. The steps below
include a screen about sales tax. The order in which that screen appears will change depending on
the type of business you selected.)

@
o  Step-by-Step: Indicate How you Enter Sales (for Retail Companies)

1. Inthe How will you enter your sales in QuickBooks? window, choose the option that best fits the
business’s needs.

p Interview
¥ Getanswers
How will you enter your sales in QuickBooks?
EasyStep’Interview _
@ Record each sale individually;
_ You can also print sales receipts to give customers.
Interview Progress " Record only a summary of your daily or weekly sales
If you use a cash register to ring up individual sales, you can enter the sales totals (forthe day,
week, etc.) into QuickBooks.
7 Use QuickBooks Point of Sale
You can send the details of each individual sale into QuickBooks—with just one click.
Need help setting up? L 8
nrur
FindALocal
< QuickBooks Expert
(fees may apply) Leave... < Back | Next= |
2. Click Next.

NOTES
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Enter Sales Tax Information

Enter Sales Tax Information

This part of the EasyStep Interview asks whether you charge sales tax. You should turn the sales tax

setting off only if you never charge sales tax. Sometimes it is even beneficial to turn this feature on for
0

tracking wholesale/retail sales, depending on the tax reporting regulations in your state.
@)

Step-by-Step: Set up QuickBooks to Track Sales Tax
1.

Click Yes in the Do you charge sales tax? window.

EasyStep Interview

Do you charge sales tax?
EasyStep’Interview

¥ Getanswers
Interview Progress

Need help setting up?

infurt
FindALocal -
< QuickBooks Expert ""‘%“
{fees may apply) = Leave... < Back E
2. Click Next.
NOTES
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Create Estimates

If you provide any type of estimate or bid — even a verbal quote — there are many reasons to use
estimates in QuickBooks. With QuickBooks estimates you can do the following:

Prepare professional-looking itemized estimates, bids, quotes or proposals for your customers

Create an invoice from the estimate with just one click; QuickBooks then creates and populates
an invoice for this customer using details from the estimate you used for that customer

Create progress invoices from an estimate if you choose

Create reports that compare your estimated costs and revenue against your actual costs and
revenue

Compare your actual costs against what you estimated

Track which estimates are still active and easily update each estimate as you continue to
negotiate with your customers

QuickBooks Desktop 2021 Client Training 16
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Create Estimates
(@]
(o)

Step-by-Step: Create Estimates for Your Business

1. Inthe Do you want to create estimates in QuickBooks? window, choose the option that best fits
the business.

EasyStep Interview

¥ Getanswers
Do you want to create estimates in QuickBooks?
EasyStep’Interview
Some businesses referto estimates as gquotes, bids, or proposals.
|
Interview Progress @ Yes

T No

Why should | use QuickBooks to create my estimates?

Need help setting up?

infurt
Find ALocal =
+ QuickBooks Expert "“L“'
{fees may apply) e Leave... < Back Next>
2. Click Next.
NOTES
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Create Sales Orders

Sales orders (available in Windows editions of QuickBooks Desktop except for Pro) allow you to
record a customer order for a sale before the sale is made. These forms are common in businesses
that order products to fill orders or that pull orders from inventory before invoicing. (Think of these
forms as “incoming purchase orders” from customers.) These forms enable you to create partial
invoices for an order if you have inventory items on backorder.

@)
o Step-by-Step: Create Sales Orders for Your Business

1. Inthe Tracking customer orders in QuickBooks window, choose the option that best fits the
business.

¥ Getanswers

Tracking customer orders in QuickBooks
EasyStep’Interview

Use a sales order to track customer orders that you plan to fill at a later date, such as backorders or
special orders.

| |
Interview Progress Sales orders can be used to track any of your unfulfilled orders or manage your inventory.

Some examples:

A bike shop receives an order for a custom-built bike. A sales order is used to track the order and is
then converted to an invoice when the customer picks up the finished bike.

Awholesaler receives an order for 1,000 couches. The sales order adjusts inventory levels to show
these couches are spoken for.

Do you want to track sales orders before you invoice your customers?

You can change a sales order to an invoice with one click.

Need help setting up? -~
infure

Find ALocal
< QuickBooks Expert e 2l

{fees may apply) e Leave... < Back m

QuickBooks Desktop 2021 Client Training 18



Lesson 2 - Setup

Choose Remaining Preferences

Choose Remaining Preferences

The next series of windows asks Yes or No questions that either enable or disable different
QuickBooks features based on your company’s needs. Click Yes or No, then click Next to move

forward in the Interview.

OPTIONS

DESCRIPTION

BILLING STATEMENTS

Post statement charges independently of invoices and sales receipts

PROGRESS INVOICING

Create multiple invoices (perhaps for different phases or milestones) from an
estimate

BILL TRACKING

Use the accounts payable module to track bills and bill payments

INVENTORY Use the inventory module to track inventory quantities and values
TRACK TIME Use timecards to track employee and subcontractor time
EMPLOYEES Use payroll module to manage employee information and payroll

QuickBooks Desktop 2021 Client Training 19
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You can always change your preference selections after the EasyStep Interview has been completed.
To change the preferences later, access the Edit menu, choose Preferences, then select the
preference type in the left panel.

Accounting A My Preferences Company Preferences @
By sis

m Pressing Enter moves between fields Bring back all gne time messages Cancel
Calendar
) Automatically open drop-down lists Turn off pop-up messages for products Help
B2 cChecking when typing and services
ﬁ Desktop View + Beepwhen recording a transaction « Show ToolTips for clipped text Default
o
Finance Charge Automatically place decimal point Warn when deleting a transaction or

€8 General “ Unused list item .
« Warn when gditing a transaction Also See:

:i Integrated Applications

Reminders
gl tems & Inventory AUTOMATICALLY RECALL INFORMATION
% Jobs & Estimates ¥ Automatically remember account or transaction information
% Mutltiple Currencies 1 Automatically recall last transaction for this name
% Payments @ Prefill accounts for vendor based on past entries

EfL Payrol & Employees

=5 )
8 Reminders

DEFALULT DATE TO USE FOR NEW TRAN SACTION S

1 Use today's date as default ® Use the last entered date as default
||I| Reports & Graphs
m Sales & Customers KEEP CUSTOM ITEM INFORMATION WHEN CHANGING ITEM IN TRAN SACTIONS
98 sales Tax ® Ask O Always O Never

p Search
[3 Send Forms

% Service Connection
Speling
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There are many settings you can customize

Choose Remaining Preferences

in the Preferences area. One such setting is the color

scheme for the company file. To change it, from the Preferences screen > Desktop View from the

left panel > My Preferences > Company
select OK.

File Color Scheme drop-down. Choose your color and

Preferences

Accounting My Preferences

B sis
m Calendar
@' Checking

& Desktop View

Finance Charge

@ General

:‘ Integrated Applications
&, ltems & Inventory

[ iobs s Estimates

ﬁ Multiple Currencies

E Payments

VIEW

) One Window

DESKTOP

@ Save when closin

Switch to colored

WINDOWS SETTINGS

Ef, Payrol & Employees
==

Reminders Display...

ol
w Sales & Customers

‘ﬁ Sales Tax
p Search
E Send Forms

Reports & Graphs

Blue-Gray
% Service Connection Blue-Green
Ao -
Speling Blue-Medium
¥
Brown

Green-Forest
EM  Green-Lime

Green-Medium

) Save current desktop

Cancel
] ® uutiple Windows ([
Help
Default
g company T Don't save the desktop
Also See:
General

+| Show Home page when opening a company file

COMPANY FILE COLOR SCHEME

Default -

Company Preferences

iconsflight background on the Top lcon Bar

Sounds...

i Orange

2 Fink

& Purple-Blue
Purple-Red
Red
Yellow
Dark-Gray

NOTES
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Choose a Start Date

The start date is the date you give QuickBooks a financial snapshot of your company assets and
liabilities before you start entering live transactions. It is generally the last day of the previous fiscal
period.

@
o Step-by-Step: Choose a Start Date

1. Inthe Using accounts in QuickBooks window click Next.

2. Choose the option that best suits the business setup.

'Step Interview

¥ Getanswers
Select a date to start tracking your finances
EasyStep’Interview
The date you select will be your start date in CluickBooks.
| . '
e . # Beginning of this fiscal year: 01/01/2021:
In order to complete this year's tax returns, you'll need to enter transactions
from the beginning of this fiscal year to today.
1 Use today's date or the first day of the quarter or month.
You'll need to enter transactions from this date forward.
What date should | choose?
Need help setting up? —
mrur
FindALocal -
< QuickBooks Expert P
ol
(fees may apply) Leave... < Back | Next> |
3. Click Next.

NOTES
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Review the Chart of Accounts

The Chart of Accounts is made up of five types of accounts common to all businesses — the income
and expense accounts used by the Profit and Loss Statement, and the asset, liability and equity
accounts used by the Balance Sheet. Each time you enter a transaction, QuickBooks will prompt you
to categorize it into one of these five accounts.

Because you chose an industry from the list earlier in the Interview, QuickBooks has already created
income and expense accounts for your company based on that choice. You can add, delete or
modify accounts long after you make this choice. QuickBooks is very flexible that way.

@
o Step-by-Step: Review the Chart of Accounts

1. Inthe Review income and expense accounts window, scroll through the preset accounts to get
an idea of what is included. Modify the selections according to your business needs by adding or
removing checkmarks.

ep Interview

¥ Getanswers
Review income and expense accounts
EasyStep’Interview
Income and expense accounts categorize money your business earns from, or spends on, normal
business operations.
|
Interview Progress 4 for your industry are typically all you need
for income tax purposes. Explain
| i ACCOUNT NAME TYPE
Merchandise Sales Income =
+ |Sales Discounts Income '
Semvice Sales Income
< |MerchantAccount Fees Costof Goods Sold
Product Samples Expense Costof Goods Sold
Purchase Discounts Costof Goods Sold
Purchases - Resale ltems Costof Goods Sold
< |Advertising and Promotion Expense
J |Automobile Expense Expense
v
Restore Recommendations
You can modify your chart of accounts anytime after completing this interview.
MNeed help setting up? L
nTur
Find ALocal
< QuickBooks Expert
(fees may apply) Leave... < Back | Next > |
2. Click Next.

Congratulations! You have completed the EasyStep Interview.
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EasyStep’Interview

]
Interview Progress

Need help setting up? —
inruT
FindALocal e
< QuickBooks Expert L
(fees may apply)

b

3. Click Go to Setup.

Review the Chart of Accounts

¥ Getanswers
You've completed the EasyStep Interview.

You now have a company file with customized settings for your business.

Mext we'll help you enter your critical business info using QuickBooks Setup.

< Back

| Go to Setup

The QuickBooks Desktop Setup screen appears. It is not mandatory to use this screen to add the lists

mentioned here (customers, vendors, items, bank accounts); there are other methods of getting this
information into QuickBooks. However, for the purposes of this training document, we will continue
with this screen.

QuickBooks Desktop 2021 Client Training
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Get all the details into QuickBooks Desktop

Add the people you do business with
Why do this? Import or enter your contacts so you can bill your customers, pay

your vendors, and track your employees. & see how it works

Add the products and services you sell
Add More

You've added 2 non-inventory parts

have. Don't worry we won't connect to your bank. & See how it works

Start Working

Add your bank accounts
Why do this? So you can track deposits, payments and how much money you

No data to enter right now? No problem. You can always add it later.

After you have completed the EasyStep Interview, use the information in the Help options described
later in this document to help you make changes and adjustments to your company file.

NOTES
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Enter Bank Accounts and Opening Balances

The balance sheet accounts in the QuickBooks Chart of Accounts start with an opening balance of
zero. Before you begin working in QuickBooks, you need to enter an opening balance for each
balance sheet account as of your start date.

@
o Step-by-Step: Enter Bank Account Information

1. Inthe Add your bank accounts section of QuickBooks Desktop Setup screen, click Add.

2. Name each bank account in the Account name column. Be descriptive with businesses that have
multiple bank accounts to eliminate confusion.

3. If you are using account numbers in QuickBooks (to identify the categories in the Chart of
Accounts), be sure to enter the corresponding number in the Account number column.
This is not where you enter the actual bank account number from the bank.

4. For Opening balance, enter the balance in the account as of the date you are beginning the file.
It is best to choose a fiscal year-end date, or at the very least, a month-end date.

5. For Opening balance date, use the date you are using to begin the file. The opening balance
amount should reflect the balance in the Opening balance date column.

{a§ Add your bank accounts acoents oot

‘You can add as many bank accounts as you'd like. The only reguired info is the account name. We won't actually connect to your bank, we'll just create a register so you
can track income and expenses.

Account name Account number Opening balance Opening balance date

Chase Checking 1000 52,879.00 12{31/2020

Chase Savings 1001 100,202.00 12/31/2020
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= IMPORTANT: The above action creates an increase to your checking account balance, an increase to your
savings account balance and an increase to your Opening Balance Equity account balance.

6. Click Continue.
7. Inthe Order Checks screen, select No Thanks (or Yes, remind me later), then click Continue.

If you selected Yes, remind me later, you will see a Create Alert screen regarding printing
checks. If this is the case, select Cancel on that screen.

8. If you are ready to import a list of customers and/or a list of vendors, click on Add next to Add
the people you do business with and follow the screens. (We will be adding customers and
vendors in another fashion later in this training.)

9. If you are ready to input the products and services you sell (also known as items), click on Add
more next to Add the products and services you sell, and follow the instructions. (We will be
adding these items later in this training.)

10. Click Start Working.

11. If applicable, follow the instructions in the Intuit account screen to use or create an Intuit ID if
you're setting yourself up as the Admin user in QuickBooks Desktop. If you're not the Admin
user, tell QuickBooks that you are signed in using the Admin credentials.

@ Sign in to company file successful.

Access to Intuit connected services:
Payments, Payroll and Tsheets requires an Intuit account.

0

Tell us who you are

® I'm the admin, and I'm the primary person who can

v Sign up for QuickBooks services: Payments, Payroll and Tsheets

v Own/operate this company or manage all financial actions
esther.us@e-compubooks.com

O I'm not the admin, I've just signed in with the admin’s

credentials.

iWhy do | need an Intuit account?;
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12. Click Continue.

13. If you specified that you're the Admin user, you'll be prompted to sign in with your existing Intuit
ID credentials, if you have them, or create a new Intuit user ID and password.

Infurt
Qi.lr."-(‘_l‘.'-n: @(‘.l.r'-'hnr:—k'—' @mwl
Sign In

One account for everything Intuit, including
QuickBooks. Learn more

Email or user ID

esther.us@e-compubooks.com

Password

g Signin

By clicking Sign In, you agree to our
Agreement and have read and acknowledge our US
Privacy Statement
Updated on January 1, 2020

| forgot my user ID or password

New to Intuit? Create an account.

Why do | need an Intuit account? Back Remind Me

14. If you specify that you're not the Admin user, you'll see a reminder telling you that you'll be
prompted in another 7 days to sign into your Intuit account. Click OK on that reminder.

15. If you haven't created a complex password already, you will be prompted to create a complex
password (at least 7 characters, including one number and one uppercase letter) for the Admin
user. Enter and confirm the new password. Select Confirm.
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ve Data Protection Setup

Create Complex QuickBooks Desktop Password

To complete sensitive data protection setup, create a new complex QuickBooks Desktop
password.

All Fields required

User Mame Admin

Mew Password ssssssses Show

Recommended te have at least 7 characters,
including one number and one uppercase letter.

Confirm New Paszsword P

16. You will see a confirmation that the password has been changed. Select OK.

op Information

NOTES

Enter Bank Accounts and Opening Balances
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Complete Company File Setup

After you have created your company file using the EasyStep Interview, you can begin using
QuickBooks to run your business.

However, there are some additional tasks you might need to do to make sure the company file is
properly set up and the data is complete.

The upcoming screen captures were created using one of the QuickBooks sample companies that
comes installed with QuickBooks Desktop, rather than the new company that was created earlier in
this lesson.

QuickBooks is Based on Four Key List Concepts:

® Accounts
® ltems
® Customers & Jobs

® Vendors

NOTES
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Add Customers

The Customer Center is the dashboard that can launch sales forms (sales orders, estimates, invoices,
sales receipts, statement charges, receive payments and credit memos/refunds) and display
accounts receivable.

@
o Step-by-Step: Add a Customer

1. There are multiple ways to do almost anything in QuickBooks. To access the Customer Center
you have four options:

® Click Customers from the left-hand or top icon bar (depending on your View settings)
® Click Customer Center from the Customers drop-down in the menu bar

® Click the blue Customers tab in the Customers section of the Home page

® Press CTRL+j

2. Click the New Customer & Job menu button, then choose New Customer.

3. Inthe Customer name field, enter the name of the customer as you'd like it to appear in the
Customers & Jobs tab list.

4. Press Tab past the Opening balance field to leave this field blank.

The Opening balance field tells you how much each customer owes you on your start date so
that when you enter the rest of your transactions from the day after your start date to today, all
balances since your start date will be accurate.

= IMPORTANT: [t is recommended to enter individual outstanding invoices one by one whenever possible,
rather than entering the outstanding balance owed in the Opening balance field.
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5. Complete the customer contact information appropriately.

You can have and use more than one Ship To address per customer or job. Add them with the
Ship To drop-down or by clicking the =+ sign in the bottom right corner.

v Customer

CUSTOMER. NAME

OFEMING BALANCE asoF 12M5/2025 B How do | determine the opening balance?
Address Info
= COMPANY NAME
Payment Settings FULL NAME | MrMs.f | | First M.l ||Last
) JOBTITLE
Sales Tax Seftings
Main Phone = Main Email =
Additional Info -
Work Phone = CC Email -
Job Info Maobile - Website -
Fax - o Other 1 -

ADDRESS DETAILS

INVOICEBILL TO SHIF TO -

Copy >> &

Default shipping address

ot | e

| Customer is inactive
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6. Click OK to add this customer. The Customer Center appears with the Customers & Jobs list
along the left side.

7. Ifthe new customer appears at the top of the list, regardless of where it belongs alphabetically,
right-click anywhere on the Customer list in the left-hand pane and click Re-sort List from the
window that appears. Select OK to confirm.

8. Any name on the Customer list can be edited by double-clicking it in the left panel or by right-
clicking it and selecting Edit Customer:Job.

Customer Center: Esther Friedberg Karp

&, New Customer &Job ¥ New Transactions ¥ (= Print ¥ Exeel ¥ word ™ & Income Tracker

ol AN/ W[

Customers & Jobs

Customers & o Customer Information U o

Active Customers hd >

Company liame EFK CompuBooks Inc. iain Prone. (416) 410-0750 No note available
ol | Fulllame  Ms. Esther E Friedberg Karp REPORTS FOR THIS CUSTOMER
| 575 EFK CompuBooks Inc
nauE fBALANGET. fATTACH | ToEra Toontonve, QuickReport
. N | orthige,
Campbell, Heather 13,00000 | Eethor EF oot o Open Balance
oRemodsl 13,000.00 ] ‘ Show Estimates
. | Map | Directions
Carrs Pie Shop 0.00 1 Customer Snapshet
+Remods! 000 | B Edit Customer —ox
» Castillo, Eloisa 0.00 EVSEIEAWL: sther Friedberg Karp
+Bay Window 0.00 1
CURRENT BALANGE 0,00 How do | adjustthe current balance?
+Utilty Room 0.00 |
+ Cook Brian 9,207.33 il
| Agdress Info cowraicy aus | EFK GompuBooks Inc .
o2nd story addition 5418.00 e _— oUNT i AvoUNT
< tenen 29793 Payment Seti FuL e [Ms Esther E | Friedoerg Karp
soaTme | President & “This Fiscal Year"
+ Graven, Pam 0.00 - 9
o Duct Work 0.00 MainPhone  + | (416) 410-0750 Main Email
- Davies, Aaron 0.00 Work Phone CCEmail
«Remodel 0.00 —
Mobile - Website  ~
+ Duncan, Dave 0.00
o Utility Shed 0.00 Fax 3 Stherd . 4
+Dunn, Eric G.W. 0.00 ADDRESS DETAILS
< Utlity Shed 0.00 INVOICEBILL TO SHIPTO -
+Easley Paula 000 EFK CompuBooks Inc s +
oGarage 0.00 10518 Toronto Ave
Northridge, CA 91326 Copy>>

+ Ecker Designs Esther E Friedberg Karp

< Office Expansion

o Office Repairs / Default shipping address
o Esther Frisdberg Karp 0.00
+ Fisher, Jennifer 0.00
«Garage Roof 0.00
oHome Remodel 0.00
+ Fomin, Slava 0.00 |
+Utility Shed 0.00 “\ “ Canca) ok
+ Freeman, Kirby 0.00 |
+Remods| Bathraom 0.00 | Customer is inactive
<Repairs 0.00

= IMPORTANT: The Customers & Jobs list is the same list as the Customer/Job list. It is called Customers &
Jobs in the Customer Center and called Customer:Job on forms. It is sometimes also referred to as
simply the Customer list. The Customer/Job list is in alphabetical order, but it is possible to drag
customers and jobs to a different spot on the list so the list is no longer alphabetical. To re-establish
alphabetical order in this list, right-click anywhere on this list and choose Re-sort List.

NOTES
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Add a Job

You do not need to add jobs to the Customers & Jobs list if your company never does more than
one job or project per customer. Jobs in QuickBooks are optional. If you often perform multiple jobs
for the same customer, you can use jobs in QuickBooks to track the activity for each job separately.

The Customer:Job hierarchy can be customized to meet many different needs and is commonly
used in construction. This feature enables you to use the Customer as a parent under which you
group multiple jobs. (Another common use of jobs is for attorneys who handle more than one matter
for each client.)

@
o Step-by-Step: Add a Job for a Customer

1. Inthe Customers & Jobs list, right-click the customer name for whom you would like to add a
job and choose Add Job.

2. Name the job in the Job name field.

3. Forthe Opening balance, refer to the information in Add a Customer in the previous section.

Customer Center. Abercrombie, Kristy

&, New Customer&Job ¥ JF] NewTransactons ¥ ) Print ¥ Excel ¥ word ¥ % income Traeker
Customers & Jobs C t I f t &
ustomer Information o o
Active Customers. - >
New Job _ox 9/1512003: Send Kristy
o estimate for den remodel.
Jos e Finished Basement el | cusroien Abercrombie, Kristy
» 912012003; Called Kristyto .
e SR A e =TI TEITE B How o | Getermine te opening alance”
+ Abercrombie, Kristy QQp e—— REPORTS FOR THIS CUSTOMER
+Family Reom 000 ' Address Info CommY NAE QuickReport
eKiehen 000 Payment Settings Funae (Mrs. | Kiisty W1 [Abercrombie Open Balance
»Remodel Bathroom 0.00 e Show Estimates
108 TME
+ Allard, Rovert 14,510.00 Addtonallo0 < onene
+Remodel 1451000 MainPhone v 4155556879 MainEmail  ~ | kisy@samplename.com
JobInfo. —_—
+ Babcocks Music Shop 000 - WorkPhone  ~ CCEmal -
Remodel 000 Mobils - Website  +
+ Baker, Chris 0.00 ——— — count AMOUNT
Fax - Other 1 -
<Family Room 0.00 00 Checking 763328
< Garage Repair 0.00 ADDRESS DETAILS 00 - Estimates 767613
o Balak, Mike 0.00 INVOICEBILL TO sHPTO - 00 - Accounts Receivable 452200
o Utility Shed 0.00 Kristy Abercrombie & + 00 - Checking 71118
B pCCTTEE ST 00 - Accounts Receivable 71118
Barley, Renee 000 : Bayshore CA94326 Copy>>
oRepairs 0.00 00 - Accounts Receivable 311128
o Bauman, Mark 0.00 00 - Checking 74375
oHome Remodel 0.00 00 - Estimates 3,114.00
© Bolinski, Rafal 0.00 00 - Checking 1,067.88
o2nd story addition 0.00 00 - Undeposited Funds 120278
» Bristol, Sonya 0.00 00 - Sales Orders 1,203.00
oRepairs 0.00 : 00 - Accounts Receivable 120278
Uob s inactivel Cancel Hel
oUtilty Shed 0.00 i “ ancel i 00 - Accounts Receivable 0.00
» Buren, Jason 1,005.00 001 5,019.08
»Room Addition 1,005.00 Invoice 1024 0210112025 1000 - Accounts Receivable 5,019.08
» Campoell, Heatner 12,900.00
»Remodel 12,900.00
+ Carrs Pie Shop 0.00
»Remodel 0.00
+ Castillo, Eloisa 0.00
+Bay Window 0.00
< Utilty Room 0.00
+ Cook, Brian 9239733 Manage Transactions |+ Run Reports -
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4. Click OK at the bottom of the new job you've created.
5. The job will now appear under the Customer (also referred to as parent) in the Customer list.

6. Close the Customer Center by clicking the X in the top right corner of the Center (not the top
right corner of QuickBooks, which will close the program!) or by hitting the Esc key.

= IMPORTANT: Notice there are more tabs with information you can add for Customer:Job setup. These
features include payment information, sales rep and job status. It is important to understand your
tracking and reporting goals to ensure these features are set up and utilized properly.

NOTES
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Add Vendors

In order to pay your bills with QuickBooks, you need to add your vendors (sometimes referred to as
suppliers). Nearly everyone you pay, other than employees, is a vendor. Your Vendor list supplies
the names available on purchase forms, including purchase orders, vendor credits, sales tax
payments, payroll tax payments and bills.

@
9! Step-by-Step: Add a Vendor

1. Just like the Customer Center, there are multiple ways to access the Vendor Center in
QuickBooks.

® Click on Vendors from the left side or top icon bar (depending on your View settings)
® Choose Vendor Center from the Vendors drop-down in the menu bar
® From the Home page, click on the Vendors tab in the Vendors section

2. Click the New Vendor button, then choose New Vendor.

3. Inthe Vendor name field, enter the name of the vendor as you'd like it to appear on your
Vendors tab list.

= IMPORTANT: In the Opening balance field, this is treated the same as the Customer Center entries. You
can enter a balance owed to the vendor as of the start date of the file, but it is a best practice to enter
individual open bills whenever possible.

4. Enter the remaining vendor information appropriately.
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5. Click OK to add this vendor.

Add Vendors

The new vendor appears on the Vendor list. (New vendors automatically appear in their correct
alphabetical order in the Vendor list.) Unlike customers, there is no job hierarchy in this list.

Vendor Center: New Vendor

New Vendor.. T New Transactons ¥ (=) Print ¥ Excel ¥ word v (g BilTracker
TS TZ 7 SNTZ LS =Y
571 ,.__}‘,,n’) | .
Vendors \%_,}\ﬁ;‘: i (=‘ V d I f t 0 @
e I ESNEZAIES
== . Vendor Information o
Active Vendors - >| 1
| Company Name  New Vendor Mo note available
el | | Full Name’
| REPORTS FOR THIS VENDOR
| Biled Frofi - New Vendar
NAME  BALANCE ... : ATTACH 1234 Main Street CQuickReport
A 8 Venice, CA
Gallion Masonry 0.00 1 140 Open Balance
Great Statewide Bank 0.00 |
Hamlin Metal 670.00 1 Wap | Directions
Hally Heating and El... 0.00 1 Order 1098 Forms
Hopkins Constructi. 700.00 1
| Order Checks
Kershaw Computer 0.00 |
Keswick Insulation 0.00 | | E
| Z]
Larson Flooring 0.00 r‘ ransactions Contacts To Do's Motes, Sent Email i"_ﬂ
Lew Plumbi 1,330.00 |
ewrumoing . | sHow Al Transacti.. = | FoErey Al - oate  This Fiscal Year * | 01/01/2024 - 123112024 §
IMadrid, Winnie 0.00 =
Wason, Elizabetn 0.00 "' TYFE i NUM i DATE v i ACCOUNT i AMOUNT ®
McClain Appliances 0.00 -
Mendoza Mechanical 000 )\ There are no transactions of type "All Transactions”, filtered by "All", in date range "This Fiscal Year
Middlefield Drywall 1,200.00 7
Willer, Dan 0.00 |
New Vendor m \
Pacific Paint Supplies 0.00 ':,
Patton Hardware Su..|  4,479.20 ' |
Perry Windows & D 6,705.00 ,\
QuickBooks Master. 0.00 “"
Rand, Jenn 0.00 | |
Reyes Properties 0.00 )\
Sergeant Insurance 4,050.00 ':‘
Sloan Roofing 1,047.00 | Manage Transactions |+ Run Reports A
bl |

6. Close the Vendor Center by clicking the X in the top right corner of the Center (not the top right
corner of QuickBooks, which will close the program!) or by hitting the Esc key.

=

IMPORTANT: Notice there are additional tabs in the Vendor setup window. Feel free to utilize these

features as they apply to your business. Pay special attention to the Tax Settings tab if you would like to

run 1099 reports from QuickBooks.

NOTES

QuickBooks Desktop 2021 Client Training

37



Lesson 2 - Setup Set Up Additional General Ledger Accounts

Set Up Additional General Ledger Accounts

During the EasyStep Interview, you added your bank accounts. Bank accounts are one specific type
of general ledger account.

There are two broad categories of general ledger accounts:

@® Balance sheet accounts, which include bank accounts and other asset accounts, liabilities and
equity accounts

@® Profitand loss (also known as income statement) accounts, such as income and
expense accounts

Income and expense accounts track the sources of your income and the purpose of each expense.
When you record transactions, you usually assign the amount of the transaction to one or more
income or expense accounts.

General ledger accounts are the core of QuickBooks. Every posting transaction (which is a
transaction that affects the general ledger) is mapped from one account to at least one other
account. For example, when you purchase paper for your office printer you are taking money from
the bank or credit card account and recording it against an office supplies expense account. Your
Chart of Accounts is home to all the general ledger accounts (also referred to as categories) that
appear on your financial reports.

@
9! Step-by-Step: Add an Account

1. From the Lists menu, choose Chart of Accounts (or press CTRL+a).

2. Click the Account menu button (at the bottom left of the window) and choose New (or press
CTRL+n from the Chart of Accounts window).

3. Inthe Add New Account window, choose the appropriate account type (by selecting the radio
button next to your choice, if it appears, or select the radio button next to Other Account Types
and choose your type from the drop-down next to it), then click on Continue.

4. If account numbers have been enabled in the Accounting Preferences (Edit > Preferences
->Accounting > Company Preferences > Use account numbers), you will be able to enter the
account number in the Number field.
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5. Click in the Account Name field and name the account appropriately.

6. Ifit's a subaccount of another account of the same type, check the Subaccount of checkbox and
specify the parent account.

7. Optionally, use the Description field to add a description.
8. Optionally, use the Note field to add an internal note.

9. From the Tax Line Mapping drop-down list, choose the appropriate mapping according to the
business structure (or leave blank if you are unsure) to help in preparing income taxes for the
company.

Add Mew Acc

N [[ Account Type Income - Mumber 40010

Account Name | Construction Consulting Income

|+ Subaccount of 40100 - Construction Income =

OPTIONAL

Description

Mote  Esthers consulting work

Tax-Line Mapping |ncome: Gross receipts or sal... =  Howdolchoose the right tax line?

Save & Close Save & New Cancel

10. Click Save & Close (or Save & New if you want to continue creating new accounts).

NOTES

QuickBooks Desktop 2021 Client Training 39



Lesson 2 - Setup Add Items

Add Items

[tems are what we use on sales forms like estimates, sales orders, invoices, credit memos, and sales
receipts. ltems represent the products or services that are sold and each item is mapped to one or
more accounts in QuickBooks. ltems can be mapped to one, two or three accounts in QuickBooks,
depending on the item setup.

® One-sided Items - These items are used only on either a sale or a purchase form, not both. For
example, if you sell consulting services, you may have an item named Consulting for use on your
invoices. This item will be mapped to an income account to view on your Profit & Loss report. If
this item were used on a purchase transaction, it would post a negative transaction to your
income account.

® Two-sided Items - These items are used on both a sale and a purchase form. The setup for these
items allows you to post to an income account when used on a sales form and post to an
expense account when used on a purchase form. In the example of Consulting as a two-sided
item, this item will be mapped to an income account on sales transactions, but will also be
mapped to a cost of goods sold or expense account on purchase transactions (e.g., when
recording sub-contractor labor).

® Three-sided Items - Three-sided items are used for inventory. The setup of these items allows
you to purchase the item and receive it into your Inventory Asset account (part 1). When you sell
the inventory, the item posts to your Income account (part 2) and makes a Cost of Goods Sold
entry (part 3).

In this section, we will look at a one-sided item entry.
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@
9! Step-by-Step: Add a One-sided Item

1. From the Lists menu, choose Item List.

Loskfor | in Allfields - Reset [ Search within results
NAME : pEscRIPTION : TvPe TOTAL QUANTITY .} ON SALES ©.. | PRICE § ATTACH
- Labor Senice 40100 - Construction Inco 0.00
+ Removal Removal labor Seniice 40100 - Construction Inco 35.00
+ Repairs Repairwork Senice 40100 - Construction Inco 3600
- Subs Subcontracted senvices Senice 40100 - Construction Inco 000
«Carpet Install carpeting Senice 40100 - Construction Inco 0.00
=Drywall Install drywall Senice 40100 - Construction Inco 000
+Duct Work Heating & Air Gonditioning Duct Work Senvice 40100 - Gonstruction Inco 0.00
<Electrical Electrical work Senice 40100 - Construction Inco 000
+Insulating Install insulation Senvice 40100 - Gonstruction Inco 0.00
< Metal Wrc Metal Work Senvice 40100 - Construction Inco 000
«Painting Painting Service 40100 - Construction Inco. 0.00
+Plumbing Plumbing Senvice 40100 - Construction Inco 000
»Roofing Roofing Service 40100 - Construction Inco. 0.00
<Tile &Counter  Instal ile or counter Seniice 40100 - Construction Inco 000
- Cabinets Cabinets Inventory Part 40100 - Construction Inco 0 0 0.00
<CabinetPulls  Cabinet Pulls Inventory Part 40100 - Construction Inco 423 0 000
+Light Pine Light pine kitchen cabinet wall unit Inventory Part 40100 - Construction Inco 8 2 1,799.00
- Door Frame standard interior door frame Inventory Part 40100 - Construction Inco 21 0 000
+ Hardware Inventory Part 40100 - Construction Inco 0 0 0.00
»Brass hinges standard interior brass hinge Inventory Part 40100 - Construction Inco. 246 0 0.00
<Doorknos Std  Standard Doorknabs Inventory Part 40100 - Gonstruction Inco 124 0 2000
«Lk Doorknobs Locking interior doorknobs Inventory Part 40100 - Construction Inco. 122 0 38.00
+Wood Door Doors Inventory Part 40100 - Gonstruction Inco 1 0 0.00
+Exterior Exterior wood door Inventory Part 40100 - Construction Inco 16 0 12000
[ Item ] Activities ¥ Reports ¥ Excel ¥ Attach nclude inactive

2. Click the Item menu button at the bottom left of window and choose New.

Item List

Lookfor in Allfields - Reset ) Search within results
NaME | DESCRIPTION : TveE uNT | TOTAL QUANTITY .| ONSALES O...| PRICE | ATTACH

- Labor Senice 40100 - Construction Inco 0.00 4

» Removal Removal labor Senice 40100 - Construction Inco 35.00

+ Repairs Repair work Senice 40100 - Construction Inco 35.00

- Subs Subcontacted senvices senice 40100 - Construction Inco 0.00
oCarpet Install carpeting Senvice 40100 - Construction Inco 0.00 l

< Drywall Install drywall Senice 40100 - Construction Inco 0.00

~DuctWork Heating & Alr Conditioning Duct Work Senice 40100 - Construction Inco 0.00

+Electrical Electrical work Senice 40100 - Construction Inco 0.00

<Insulating Install insulation Senice 40100 - Construction Inco 0.00

o Hletal Wrk Hietal Work senice 40100 - Construction Inco 0.00

Senvice 40100 - Construction Inco 0.00

ot lem TUE Senice 40100 - Construction Inco 0.00

Duplicate ltem Senice 40100 - Construction Inco 0.00

Delete ftem C+D  unter Senice 40100 - Construction Inco 0.00

. Add/Edit Multiple ltems Inventory Part 40100 - Construction Inco 0 [} 0.00

Edit Markup. Inventory Part 40100 - Construction Inco. 423 o 0.00

Make Item Inactive len cabinet wall unit Inventory Part 40100 - Construction Inco 5 2 1,799.00

.+ Show Inactive tems or door frame Inventory Part 40100 - Construction Inco 21 [i] 0.00

. v Hierarchical View Inventory Part 40100 - Construction Inco. [ [ 0.00

ZS:::“’E P or brass hinge Inventory Part 40100 - Construction Inco 246 0 0.00

knobs Inventory Part 40100 - Construction Inco 124 o 30.00

Use G gporknobs Inventory Part 40100 - Construction Inco. 122 o 38.00

| Endin Transadions. Inventory Part 40100 - Construction Inco 1 0 0.00

Print List. Ctl+P Hgar Inventory Part 40100 - Censtruction Inco. 16 0 120,00
 Resortlist v

'E W ?pons ¥ | Excel |v | Attach | [J Iinclude inactive

QuickBooks Desktop 2021 Client Training 41



Lesson 2 - Setup Add Items

3. Inthe New Item window, choose an item type from the Type drop-down list.

= IMPORTANT: When you select an item type, a description of how that item should be used will appear to
the right of the drop-down box.

- Mew [tem P

sefor services you charge for or purchase, like “

-
specialized labor, consulting hours, or professional Cancel
fees.
Next
ltem Mame/Mumber [ Subitem of
Notes
UNIT OF MEASURE Custom Fields
LM Set - Edit... Spelling

[] This service is used in assemblies oris performed by a subcontractor or partner

Description Rate

Tax Code  Tax -

[ ] isi i
Account | tem is inactive

&

Assign an item name or number in the ltem Name/Number field.

5. Inthe Description field, enter the information you would like to appear by default when this item
is used on a form. (This default information can be overwritten on any individual transaction.)

6. You can assign a standard per unit selling price in the Rate field.

7. Inthe Tax Code field, assign a standard taxable or non-taxable code.

= IMPORTANT: [tems marked non-taxable in the setup will not accrue sales tax on sales forms. See the
Sales Tax training section for additional information.

8. Inthe Account field, choose the appropriate income account to post to when this item is used on
sales forms.
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9. Click OK to add the new item to the Item List.

= Mew ltem
TYPE . . | oK
— » Useforsenvices you charge for or purchase, like
specialized labor, consulting hours, or professional Cancel
fees.
Hext
[term Mame/Mumber ] Subitem of
Notes
Drafts -

UNIT OF MEASURE Custom Fields

LM Set - Edit... Spelling

7] This semnvice is usedin assemblies oris performed by a subcontractor or partner

Description Rate

Draft blueprints Tax Code Maon -

Account 40100 - Constr.. = [ Item is inactive

10. Close the Item List.
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Enter Historical Transactions

If your QuickBooks start date for a new business (starting to record transactions in QuickBooks from
the very inception of the business) is before today’s date, you need to enter past transactions so you
have complete financial records from the start date going forward. (Existing companies that have
been in business for some time before starting to use QuickBooks will require more steps.)

@
9! Step-by-Step: Enter Historical Transactions in this Order

1. All sales (sales receipts, invoices, credit memos or statement charges) issued on or after the start
date.

2. Customer payments received for outstanding invoices on or after the start date.
3. Bills and bill credits (also known as vendor credits) received on or after the start date.
4. Bills paid since the start date.

5. Deposits made to any of the accounts on or after the start date.

6. Any other checks written and credit card charges made (other than to pay bills), as well as bank
charges and pre-authorized payments on or after the start date.

NOTES
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Set Up QuickBooks — Review Questions

1.

During the EasyStep Interview, QuickBooks creates income and expense accounts based on
your company’s

When setting up a company file in QuickBooks, what does the start date signify?
a. The date the business was created

b. The first date of the company’s fiscal year

c. The date the company purchased QuickBooks

d. The date from which you will be entering transactions in QuickBooks

When setting up a company file in QuickBooks at the beginning of a fiscal period, you would
normally select which of the following as the start date?

a. The first day of the current fiscal period
b. The last day of the previous fiscal period

True or false: Once you have set up the Chart of Accounts, you cannot add, delete or modify
accounts.

a. True
b. False
Before working in QuickBooks, you need to enter an for each

balance sheet account.

True or false: Choosing a company organization associates a tax form with your business in the
QuickBooks file.

a. True

b. False
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7. In QuickBooks, linking income and expense accounts with tax lines does which of the following?
a. Helps keep your company profitable
b. Helpsin preparing income taxes
c. Helps keep track of sales taxes you owe

d. Bothbandc
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Answers to Review Questions

1. During the EasyStep Interview QuickBooks creates income and expense accounts based on your
company's industry.

2. When setting up a company file in QuickBooks, what does the start date signify?
a. The date the business was created
b. The first date of the company’s fiscal year
c. The date the company purchased QuickBooks
d. v The date from which you will be entering transactions in QuickBooks

3. When setting up a company file in QuickBooks at the beginning of a fiscal period you would
normally select which of the following as the start date?

a. The first day of the current fiscal period
b. v The last day of the previous fiscal period

4. True or false: Once you have set up the Chart of Accounts you cannot add, delete or modify

accounts.
a. True
b. v False

5. Before working in QuickBooks you need to enter an opening balance for each balance sheet
account.

6. True or false: Choosing a company organization associates a tax form with your business in the
QuickBooks file.

a. v True

b. False
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7. In QuickBooks, linking income and expense accounts with tax lines does which of the following?
a. Helps keep your company profitable
b. v Helps in preparing income taxes
c. Helps keep track of sales taxes you owe

d. Bothbandc
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